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Class Summary

Universities set up relationships with companies as a way to bring real-world
experience to the students. The students get a better understanding of
production needs, practical working experience, and production credit prior to
graduation. The university gets support from a production house and a
connection to benefit future students. For the production company, this
provides an increased labor force, an opportunity to share work practices,
and potential employees after graduation. There are opportunities to make a
successful connection and provide students great hands-on experience while
INn school, along with some pitfalls. During this class, we will talk about how to
work effectively with production houses in a university setting and cover
some of the pitfalls you may encounter along the way.
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Learning Objectives

At the end of this class, you will be able to:

» The benefits of acting as an outsource company Iin a university setting
« |[dentify potential pitfalls for the students and the educational system

» Ensure students get true value from the actual production

» Develop a win-win synergy with the client
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Full Sail University Overview
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Full Sail University

« Founded In 1979 providing audio workshops
with the philosophy “everyone deserves a
chance”

« University Status was accepted in 2008

= Full Sall Institute of Research In
Entertainment began in 2009
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Full Sail University
» Located In Winter Park Florida
= 191 Acre Campus

« 880,000+ square feet of state-of-the-
art media production facilities

= 110+ Studios / Labs, 60+ Classrooms
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Full Sail University

« 25 Bachelor's Degrees
« 8 Master's Degrees

« The Bachelor Degree
» 21-month accelerated
« 32-month hybrid
» 36-month extended
= 32-month online

« Master's Degree
« 12-months
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BACHELOR'S MASTER'S
Computer Animation Entertainment Business
Creative Writing for Game Design

Entertainment

Digital Arts & Design

Entertainment Business ASSOCIATE'S
Film Graphic Design
Game Art Recording Engineering

Game Development

Music Business

Recording Arts CERTIFICATE PROGRAMS

English as a Second

Show Production Language

sports Marketing & Media

Web Design & Development

DEGREE CATEGORIES BY SCHOOL

Film School Game School
Art School Business School
Music School Design School

ONLINE C_L

BACHELOR'S
Computer Animation

Creative Writing for
Entertainment

Digital Cinematography
Entertainment Business
Game Art

Game Design

Graphic Design
Internet Marketing
Mobile Development
Music Business

Music Production

sports Marketing & Media

Web Design & Development

GRADUATE CERTIFICATE:

Education Media Design &

Technology

Internet Marketing

MASTER'S
Creative Writing MFA

EBMS: Sports Management
Elective Track

Education Media Design &
Technology

Entertainment Business
Internet Marketing
Media Design

New Media Journalism
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Full Sail University

» Day In the life (Campus)
« 8-hours a day
= 4-hour lecture followed by 4-hour lab
= 24-hour round-the-clock schedule

« Staffing
= 120 + Full time educators in 3D Arts
« Industry Professionals
= Continue to freelance
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The benefits of acting as an outsource
company in a university setting
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Acting as an Outsource Company

» Full Sall Institute for Research and Entertainment — F.I.R.E.

« Established in 2009, Full Sail's Institute for Research in Entertainment
provides faculty members and students with the opportunity to work
collaboratively on research projects for professional organizations and
companies.

» Research Is a natural compliment to academics
= Designed for instructional staff to conduct both basic and applied research
= Production activities within the educational environment
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Acting as an Outsource Company

» The educational staff benefit:
» Enhances the instructor's knowledge of his/her discipline.
« Provides real world examples for the classroom.
» Provides an avenue for intellectual growth.

« Enhances the reputation of Full Sail University by creating publishable
material and finished products.
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Acting as an Outsource Company

» Other Benefits to the University

» Increase potential employment opportunities
« Opportunity to grow project-based learning
« Broaden the student experience

« Gain real world experience

» Research new production ideas

« Networking opportunities

« Importance of Deadlines
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Acting as an Outsource Company

» Industry Benefits

« Expanded visual elements / production
assets

« Helping to produce new ideas and possible
solutions to problems

= Potential staffing growth after graduation

» Possibilities of company branded labs on
university
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Acting as an Outsource Company
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http://www.youtube.com/watch?v=WcfV07x_Fso
http://www.youtube.com/watch?v=qrvZkUolruA&feature=relmfu

Acting as an Outsource Company
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Acting as an Outsource Company

« The Research Project

» Principle Investigator helps define project needs
« Client
 Internal Project
» External Project
» Development
« Understand the research perspective
« Understand the client perspective
= I[N various instances — help define the project needs
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Acting as an Outsource Company

» Understand the timeline
» Deadlines
» Immediate need | V/Set date and time automatically: |Apple Americas/U.S. (time.apple.com) |~
= O
» Time for research

11/12/2012 7:05:34 PM

Mov 2012

« |dentify research type
= Short term
» Long term ettt e s anpg & Tt prfrences
. Research type '
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Acting as an Outsource Company

« Funding for projects Is important
» Principle investigators must understand the sponsor’s potential funding
» Defines a level of respect to a project
« Ensure this Is not a struggling economy situation
« Creates funding to support hardware and software
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Acting as an Outsource Company

« Internal Project may require grant money

» Proposal Writing
» Foundation Center
» Nttp://foundationcenter.org/getstarted/tutorials/shortcourse/index.html
« The Art of Grantsmanship
= Nttp://www.utoronto.ca/cip/sa_ArtGt.pdf

-
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Acting as an Outsource Company

» Review

« Assemble the team

» Art Leads for the project
« Staff members with skills that fit the project
» Dedicated to the process

« Students
« Skills / Strengths In area of need
 Where they are In the program
» Students apply with portfolio / knowledge of particular area
» Reputation review

« Research Begins...
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ldentify potential pitfalls for the students
and the educational system
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Potential Pittalls

» Industry Goals
» Increase Profit
» Increase Market Share
« Expanding Current Product Lines
« Improving Employee Retention Rate

= (smallbusiness.chron.com)
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Potential Pitfalls

« Education Goals
= Facilitate learning for the student
« Encourage discovery
» Provide an engaging learning system for diverse learners
« Help students take responsibility for their learning

= Provide an opportunity for the individual to chase the dream...
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Potential Pitfalls

» Education Goals

» Full Sail’s mission 1s to provide
students with an innovative style of
education, delivered by a staff of
dedicated individuals, that address the
career opportunities available in an
ever-growing, constantly evolving
Industry.

« Shaping tomorrows industry
professionals!

EPIC MICKEY
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Potential Pittalls

» Education Goals and Industry Goals
« Don’t match up.

AU Autodesk University © 2012 Autodesk



Potential Pittalls

« Economic
« Student labor can be seen as free labor
» Industry may see a collaboration as an opportunity to save money
« Struggling economy
» Loss of staffing
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Potential Pitfalls

« Understanding the Timeline

» Does the timeline fit with student / staff schedule?
» The student has a heavy workload
« On average 40 contact hours a week (Full Sail standards)
» Continued art work development out of class
» Research and other course related work

« How to fit extra time for industry work?
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Potential Pitfalls

= The Student Ambition / Ethics
« Involved In the project enough to complete
» Loss of Interest over length of time
« Work ethics match with project (content)
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Potential Pitfalls

« Undermined academic standards
» Does the project align with the standards set by the university
« Teaching short cuts before the student is ready?
« Conflict of interest coursework versus production project
« Will the student select the project?
« Have strong time management skills developed?
« Will quality suffer because of classroom instruction
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Potential Pitfalls

» Review
» Industry Goals vs. Education Goals
= ECconomic
= TiImeline and students schedule
» Students ambition / ethics
 Undermined academic standards
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Ensure Students get True Value from the
Actual Production
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Students get True Value

« Develop working knowledge of real world pipeline
= Pitch to potential clients
« Assist In setting up production pipeline
« Learn to troubleshoot problems
« Understanding and resolving problems in production
=« A true value that can not be taught in the classroom
« Develop time management skills to meet production deadlines

AU Autodesk University © 2012 Autodesk



Students get True Value

« Networking opportunities
» Industry connection
« Other students in varied disciplines
« New networking with instructors

« Developing Experience Outside the Classroom

« Develop a working understanding of a client prior to leaving
« Exposure to real milestones
» Client changes
« Education opportunity to engage the student with “client” based work
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Students get True Value

« Understands Responsibility
« Time management balance:
« Coursework
« Production
« Personal / Family
» The student develops stronger work habit (ethics)
« Commit to the production/research
« Completion of assets/development
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Students get True Value

« Practical work experience prior to graduation
« Ensure Proof of work
 Include In contract release to show content
« TImeline when work can be released
« Named credit in production
« Letter from production/director

= ECOnomic
= Money
= Feed the student
« Equipment
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Students get True Value

« Strengthens the Educational team experience
« Educational team has Iindustry experience
« Acting as leads on production

= Direction and support to the students working on research
« Comfort of working In the University versus pressure of industry

» Re-enforces educators credentials and abilities to do production work
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Students get True Value

» Review « Pitfalls - Review

» Develop working knowledge of real » Industry Goals vs. Education Goals
world pipeline « Economic

» Develop time management skills to « Timeline and students schedule
meet production deadlines . Students ambition / ethics

= Networking opportunities . Undermined academic standards

» Developing experience outside the
classroom

» Practical work experience
« Economic support

« Strengthen the educational
experience
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Develop a win-win synergy with the
client
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Develop a Win-Win

= Educate the client

« Provide an understanding
« Universities educational practices
« Equipment and resources available
» Course load of the students
« Staffing and strengths
« Course structuring
» Desired outcomes of collaboration
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Develop a Win-Win

« Support the mission of both university and industry

« University
= Faclilitate learning for the student
» Encourage discovery
= Provide an engaging learning system for diverse learners
« Help students take responsibility for their learning

« Industry
» |ncreased Profit
= [ncrease Market Share
« Expanding Current Product Lines
« [mproving Employee Retention Rate
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Develop a Win-Win

« University supports Industry Mission
« Training potential future employees
» Providing access to a diverse knowledge
« staff knowledge
= students unigue perspective on looking for solutions
« Advancements to industry growth through research
« Access to university facilities, equipment, and other resources
« Supporting economic growth

 providing opportunities to grow outside the company without the burden
of Increased costs

« Providing content or feedback on new developments
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Develop a Win-Win

« Industry supports University Mission
« Potential employees after graduation
« ECconomic
« Donation of equipment
» FInancial
« Employees (Company)
= Support of knowledge to project
« Guest lecture
« Access to production technology
» Provide real world problems to be resolved
« Assist In developing new training content
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Develop a Win-Win

» Develop Long-Term Relationship

« The relationship between industry and university should be more than an
Isolated project

« Short term project a stepping-stone
« Negotiate budget of the project
» Completed project
» Long-term relationship
« Strengthens the value between university and corporation
» Understanding of corporation needs
» Understanding university / student growth opportunity
» Speeds up negotiation — more time spent to research
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Develop a Win-Win

» Proactively manage the industry / university relationship

« University / Industry outreach person
» Person who maintains regular client interaction
« Understands the technical side of production and how teams interact

« Individual helps build long-term relationship and cultivates the growth with
the university.

« Assists In maintaining the shared vision of collaboration

« Defined goals of the project meet with student needs as well as company
needs
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Develop a Win-Win

« Strengthen Communication
« Conflicts will arise and must be communicated clearly, sensitive to all parties.
» Develop and maintain strong communication

« Regular Face-to-face meetings (virtual can work) to help ensure
communication remains open.

» Create a standard routine for updates in addition to meetings (i.e. Project
content review - concept share)

« Complements from client is a strong building factor

« When possible encourage company to visit campus and meet with
team, and visit client’s office.
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Develop a Win-Win

« Intellectual Property
« Inventions made by Private Contractor are owned by the originating company
« If made by both private contractor and university owned jointly
« Contract determines who applies for license / patent.

« Background / Intellectual properties of the contractor or university are
separate property.

= Commercilalization

= Promotion of technologies / content created is strictly for the purpose of
promotion of the research institute.
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Develop a Win-Win

« Share the collaboration efforts with team
» Provide information about upcoming projects
« Collaborations with other departments
« Impact this project will have on university
« Ensuring connection with company
« Students strength In project
« Continued support for future production

« Generates knowledge with others who may network with potential companies
for future work.
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Develop a Win-Win

« Review

« Education of the client

« Support the mission of both university and industry

» Develop long-term relationship

« Proactive industry/university relationship manager
» Develop a long-term relationship
» Strengthen communication

 Intellection Property

« Shared collaboration
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Review: Learning Objectives

You how understand:

» The benefits of acting as an outsource company Iin a university setting
« |[dentify potential pitfalls for the students and the educational system
» Ensure students get true value from the actual production

» Develop a win-win synergy with the client
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The Pittalls and Success of Professional
Production and Students

.Q&A
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